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What's New

What's New in Tl Connect™ CE Software
Tl Connect™ CE

e Explorer Workspace

Send or Convert a Python AppVar to the Computer (*.py or *.8xv)

A Python program (PY AppVar) will save from the CE to a computer as *.py file.
Open the *.py file in a text editor to view or edit the file for the CE Python
experience. As in previous releases, TI-SmartView™ CE and Tl Connect™ CE
Explorer will send/convert *.py files to the calculator file type, PY AppVar.
There is no need to save the CE PY AppVar on your computer.

Convert an image for use in the Python App with the ti_image Add-On module

When sending an image from a computer to a connected CE, an additional

image conversion option is available to convert and send the correct Python
image AppVar format to the CE. Then, using the Python App, import the ti_
image Add-On module to use the image in your program.

Always

update with the latest CE bundle at:

education.ti.com/83ceupdate

education.ti.com/fr
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Introduction to the Tl Connect™ CE Software

The Tl Connect™ CE software makes exchanging information between your graphing
calculator and your computer quick and easy.

Supported Tl Graphing Calculators
Supports any TI-8x graphing calculator with a USB port, which include:

e TI-84 Plus CE Python* and TI-84 Plus CE
e TI-84 Plus CE-T Python Edition* and TI-84 Plus CE-T
e Tl 84 Plus CSilver Edition

e TI-84 Plus

e TI-84PlusT

e TI-83 Premium CE Edition Python and TI-83 Premium CE
e TI-83 Plus.fr

e TI-82 Advanced

e TI-82 Advanced Edition Python

*Note: TI-84 Plus CE family calculators will display as TI-84 Plus CE.

Note: Use Tl Connect™ 4.0 which supports calculators with an 1/0 port only:
e TI-83 Plus

e TI-89 Titanium

e Voyage™ 200

e TI-73 Explorer™

Note: Tl Connect™ CE does not support connectivity with the TI-Nspire™ family.
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Using the Tl Connect™ CE Software

The TI Connect™ CE software contains tools you can use to exchange information
between your calculator and your computer.

£2 T Connect™ CE - o X
Fichier ~ Modifier  Afficher  Actions  Ressources
] oe
CALCULATRICES CONNECTEES (1) ©
= *Capturer 1 X
& g gls-as Premium CE Edition Python ©

X/

*Capturer 3 X
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The Tl Connect™ CE software includes three workspaces:

e Screen Capture: allows you to manage screen captures
e Calculator Explorer: allows you to manage calculator content

* Program Editor: allows you to manage Tl Basic programs
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Parts of the Tl Connect™ CE Software

2 TI Connect™ CE ~ - o
Fichier Modifier Afficher Actions Ressources Aide
] o e 3 75%
CALCULATRICES CONNECTEES (1) ©
*Capturer 1 X
TI-83 Premium CE Edition Python
o B e @

[4) H0.666667 )

o Menu Bar - Use these menus to manage calculator files and screens to view
calculator information, and to get help.

Fichier Modifier Afficher Actions Ressources Aide

9 Toolbar - Use these icons to manage computer files and screens.

@ Workspace Panel- Use this panel to select workspaces (Screen Capture,
Calculator Explorer, and Program Editor).

L=d

e Calculator List Panel - Use this list to view all connected calculators and to
select one calculator for display.

CALCULATRICES CONNECTEES (1) (O]
TI-83 Premium CE Edition Python g
B

e Content Panel - Use this panel to view and manage the calculator files and
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screen on connected calculator(s).

#2 71 Connect™ CE - o X

Fichier ~ Modifier  Afficher  Actions  Ressources  Aide

p=| c

6]  CALCULATRICES CONNECTEES (2) TI-83 Premium CE Edition Python  Archive: 1232 ko disponibles | RAM : 146 ko disponibles
g] @ TI-83 Premium CE Edition Python - 4652 ow oo TARE FHpLACaENT
os (] Matrice 560 Mémoire RAM
@ O (e @ A AppVar Python 550 Archive
e {} Asa Liste réelle 1280 Mémoire RAM
{-} Asc Liste réelle 20 Mémoire RAM
@ ARROW AppVar Python 2120 Archive
@ ARRW AppVar Python 2320 Archive
® B AppVar Python 2610 Archive
@ BONJOUR AppVar Python 2910 Mémoire RAM
@ BUTNTEST AppVar Python 6050 Archive
@ cabrir Application Flash 102ko Archive
{-} cases Liste réelle 5330 Mémoire RAM
@ Ccelsheet Application Flash 123ko Archive
@ conics Application Flash a2ko Archive
@ DASH1 AppVar Python 5650 Archive
@ Deutsch Application Flash 46ko Archive
@ DISPTEST AppVar Python 1ko Archive
(@ easypata Application Flash 167ko Archive

Note: You can complete most of the actions in these menus by dragging and
dropping items to your connected calculator or computer.

Using the Tl Connect™ CE Software 5



Using the Screen Capture Workspace

The Screen Capture workspace allows you to manage calculator screen captures.

£2 T Connect™ CE - o X

Fichier Modifier Afficher Actions Ressources

[] m]

CALCULATRICES CONNECTEES (1)
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Note: Before connecting for a Screen Capture, display the Screen Capture workspace in
view.

Next, connect your calculator to capture the current screen on the calculator.

If a different workspace is in view, such as Calculator Explorer, when the calculator is
connected, the calculator will display the Home Screen. You will have to redisplay the
desired calculator screen for the screen capture.

6 Using the Screen Capture Workspace



Parts of the Screen Capture Workspace

Menu Bar - Use these menus to manage files and images, to view calculator
information, and to get help.

Fichier Modifier Afficher Actions Ressources Aide

Note: You can complete most of the actions in these menus by dragging and
dropping items from the Content Panel.

Toolbar - Click these icons to save, send, copy, delete, and resize files.

Save a file to the computer.

Send a file to a calculator.

Copy a file.

Delete a file.

Add or remove a border from all captured screens.

Change the size of all captured screens.

(Nl o~ oo -

View the screen capture size.

Content Panel - View screen captures in the Content Panel.

*Capture 1 *

[NORHAL FLOTT AUTO REEL RAD HP D

Capturing and Using Screens

In the Screen Capture workspace, you can capture and view screens from your
calculator.

Using the Screen Capture Workspace



Before you Begin

Connect the calculator to the computer and make sure it appears in the Calculator List
Panel.

To Capture Calculator Screens

1. Onthe Tl Connect™ CE software Workspace Panel, click the Screen Capture
workspace.

2. Display the screen on your calculator that you want to capture.
3. Click next to the desired calculator in the Calculator List Panel.

e If more than one calculator is connected, click on @ next to CONNECTED
CALCULATORS to capture screens from all calculators.

Dragging and Dropping Screen Captures to Computer Applications

Using the Screen Capture workspace, you can drag and drop captured screens into
many computer applications. This feature lets you use calculator screens in your
documents.

To drag and drop screens into computer applications
1. Open or capture the screen.

2. Drag and drop the screen to an open document or presentation computer software
application.

Note: You may also use Edit>Copy>Paste into an open document or presenter computer
software application.

Saving Calculator Screens as Files

The Screen Capture workspace lets you save captured or existing images from your
calculator as a PNG.

*Capture 1 ¥

[NORHAL FLOTT AUTO REEL RAD HP

Note: The asterisk at the beginning of an image name indicates that the image is not
saved.

To save an existing screen

1. Click the captured screen in the Content Panel.

8 Using the Screen Capture Workspace



2. Click .

To save multiple screens
1. Click Edit > Select All.

2. Click .

To rename a screen capture

1. Place your cursor at the beginning of the screen name field.
Ex: Capture 1.

2. Double-click the name to select it.
3. Type in a new name for the computer file.
To save a new screen capture as a PNG file

1. Click the image.

2. CIick.

3. Navigate to a desired save location.

4. Use the default file name or type a new file name.

5. Click .

To send screen captures to connected calculators

This Screen Capture only feature provides a way to take a screen capture of a graph on
the high resolution calculators, crop to the graph area and then convert only the graph
area to a Background Image. Check Graph Area Only to create this type of Background
Image.

1. If you have not already done so, capture the screen.

2. Click the screen capture to select it.

Al
3. Click
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2 Envoyer aux calculatrices

NOM DE FICHIER : NOM SUR LA CALCULATRICE : EMPLACEMENT : ]

Capturer 1 Image1 v U

Les captures d'écran et les fichiers images convertis seront envoyés comme
variables Pic aux calculatrices en noir et blanc.

— Espace de travail

CALCULATRICES DE DESTINATION :
Graphiques uniquement

) Toutes les calculatrices connectées _) Sélectionnez des calculatrices

__| Remplacer |e contenu existant portant le méme nom sur les calculatrices de destination

e FILE NAME: This may differ from the NAME ON CALCULATOR depending on what
you named the screen capture on your computer.

e NAME ON CALCULATOR: select the background image (it should be the default, but
you may change the background image name using this menu).

Note: Screen captures and converted image files will be sent as Pic Vars to gray
scale calculators.

e GRAPH AREA ONLY: In the right panel, select whether you want to send just the
graph area, or the entire screen. When sending a screen capture back to a
calculator, it is best to send the graph area only.

10 Using the Screen Capture Workspace



Cropping a Screen Capture of the Graph Area

A screen capture of the graph area includes the full screen of the TI-83 Premium CE
Edition Python, status bar, graph border, and the graph area.

Tl Connect™ CE software allows you to crop the image to a Graph Area Only size to
create a Background Image Var. You can crop a screen to Graph Area only in the
Send to in the Send to Calculators dialog box.

W

WA (R

.| Graph Area Only || Graph Area Only
e DESTINATION CALCULATORS: Select whether you want to send the image to all
connected calculators, or just selected calculators (from a check list).
To send files to multiple calculators
1. Select the Select Calculators button on the dialog box.
2. Check the boxes to next to the calculators you want to select.
3. Click Send.

Using the Screen Capture Workspace 11



Using the Calculator Explorer Workspace

Calculator Explorer workspace allows you to manage calculator content.

2 Tl Connect™ CE - u] X

Fichier ~ Modifier  Afficher ~ Actions  Ressources

©

6  CALCULATRICES CONNECTEES (2) TI-83 Premium CE Edition Python  Archive: 1232 ko disponibles | RAM : 146 ko disponibles
B % T1-83 Premium CE Edition Python - 4652 row oo e FupLAcENT
= [=] Matrice 560 Mémoire RAM
@ T @ A AppVar Python 550 Archive
os {} Asa Liste réelle 1280 Mémoire RAM
{-} Aec Liste réelle 20 Mémoire RAM
@ ARROW AppVar Python 2120 Archive
@ ARRW AppVar Python 2320 Archive
L] AppVar Python 2610 Archive
@ BONJOUR AppVar Python 2910 Mémoire RAM
@ BUTNTEST AppVar Python 6050 Archive
@ cabrir Application Flash 102ko Archive
{-} cases Liste réelle 5330 Mémoire RAM
@ Ccelsheet Application Flash 123ko Archive
@ conics Application Flash 42ko Archive
@ DAsHI AppVar Python 5650 Archive
@ Deutsch Application Flash 46ko Archive
@ DISPTEST AppVar Python 1ko Archive
@ easypata Application Flash 167ko Archive
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Parts of the Calculator Explorer Main Workspace

Menu Bar - Use these menus to manage files and images, to view calculator
information, and to get help.

Fichier Modifier Afficher Actions

Note: You can complete most of the actions in these menus by dragging and
dropping items from the Content Panel.

Toolbar - Click these icons to add, transfer, or delete files from your calculator.

&
OO 0 6

Add content from your computer.

Send selected content to your computer.

Send selected content to another connected calculator.

Delete the selected file.

Refresh the view of a connected calculator's contents.

oy i~ ol = =Y |7

Content Panel - Select files you want to manage from this panel.

2 Tl Connect™ CE - u] X
Fichier  Modifier  Afficher ~ Actions  Ressources  Aide
p= €
[6)  CALCULATRICES CONNECTEES (2) T1-83 Premium CE Edition Python  Archive : 1 232 ko disponibles | RAM : 146 ko disponibles
-
G| E T1-83 Premium CE Edition Python - 4652 ow e TAE SupLAcaENT
os =] Matrice 560 Mémoire RAM
7 - A Archiv
(1] % L p——— 2 A ppVar Python 550 chive
os {} Asa Liste réelle 1280 Mémoire RAM

{~} Asc Liste réelle 20 Mémoire RAM
@& ARROW AppVar Python 2120 Archive
& ARRW AppVar Python 2320 Archive
L AppVar Python 2610 Archive
@ BONJOUR  AppVar Python 2010 Mémoire RAM
@@ BUINTEST  AppVar Python 6050 Archive
@ cabrir Application Flash 102k0 Archive
{-} cases Liste réelle 5330 Mémoire RAM
@ celsheet Application Flash 123ko Archive
@ conics Application Flash 420 Archive
@ DASHI AppVar Python 5650 Archive
@ Deutsch Application Flash 46ko Archive
@& DISPTEST AppVar Python 1ko Archive
@ easypata Application Flash 167ko Archive
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Selecting a Connected Calculator

The Tl Connect™ CE software allows you to simultaneously connect multiple
calculators. Click on the calculator you want to work with to select it. The selected
calculator becomes the default calculator for all TI Connect™ CE software actions.

Before you Begin

Connect the calculator to the computer and make sure it appears in the Calculator List
Panel.

Copying Calculator Files to the Computer

You can copy most data, files, and programs from your calculator to your computer as
a content backup, to send to others, or to free up calculator memory.

|Warning: Do not disconnect the cable during a transfer.

To copy a file from the calculator to the computer
1. Click on the file name to select it.

2. Drag and drop the file into a folder on your computer or onto your desktop.

Warning: Do not disconnect the cable during a transfer.

To copy file(s) from the calculator to the computer as a content backup
1. Select Edit
2. Select All

3. Drag and drop the file(s) into a folder on your computer or onto your desktop.

Note: There is no auto backup feature in Tl Connect™ CE.

Copying File(s) from the Computer to Connected Calculators

|Warning: Do not disconnect the cable during a transfer.

To copy file(s) from the computer to the calculator

1. Navigate to the desired file(s) on your computer.

2. Drag the file(s) to the Calculator List Panel and hover over the desired calculator.
3. Release the mouse button when you see % Copy
4

Select a file name from the drop-down menu. This will be the name of the file on
your calculator.

5. Click Send.

14 Using the Calculator Explorer Workspace



Sending Files Between Connected Calculators

You can send compatible files between connected calculators with Tl Connect™ CE
software.

|Warning: Do not disconnect the cable during a transfer.

To send files to connected calculators
1. Click the file(s) in the Content Panel to select it.

2. Click .

2 Envoyer aux calculatrices X

CALCULATRICES DE DESTINATION :

) Toutes les calculatrices connectées _) Sélectionnez des calculatrices

] Remplacer le contenu existant portant le méme nom sur les calculatrices de destination

e DESTINATION CALCULATORS: Select whether you want to send the file to all
connected calculators, or just selected calculators (from a check list).

To send files to select calculators

1. Select the Select Calculators button on the dialog box.

2. Check the boxes next to the calculators you want to select.
3. Click Send.

Note: When connecting the TI-82 Advanced Edition Python, Apps will not display in
the Explore View. Apps cannot send, receive or be deleted on the TI-82 Advanced
Edition Python. Other CE variables such as list, matrix, Image, Pic, Python programs
(PY AppVars), TI-Basic programs will send/receive up to version compatibility.

Using the Calculator Explorer Workspace 15



Converting and Sending Background Images for use in the CE Graph
Area

The TI-83 Premium CE Edition Python can display Background Image Vars and Pic Vars.
These variables display in the graph area.

Note: All information on background images also applies to the CE calculators and TI-
82 Advanced Edition Python.

Work with Background Images on Color Calculators

The Tl Connect™ CE software automatically converts any image you send to a
connected calculator into a Background Image Var. Your image may display differently
in the graph area than you expect given the conversion to the pixel dimensions of 83 x
133.

Note: For best results, please edit your image to be proportional to 83 x 133 pixels
prior to the conversion to 83 x 133 pixels.

Tip! Try to convert your image as described below. If the conversion is not as you
expect, scale your picture similar to the graph area where Background Image Vars
are displaying on the CE.

e Take a screen capture of the graph screen at 100% scale using Screen Capture
Workspace. This screen capture can be either in Full or Graph-Table mode. You
will use this to scale your image to a smaller size to fit the size of the graph
area.

e Use a favorite presentation software and display both the screen capture and
your picture.

e Drag (size) your picture to a smaller size and to the proportion of the graph
area.

e Use a snipping tool to snip the new smaller image. Save that image to your
computer.

e Use this smaller, proportional picture to convert to an Image Var following the
next steps below.

Reminder! Preserve your original picture file by using a different computer file
name of your smaller picture.

The conversion to the Background Image Var uses 16-bit color.

You can also convert or upload a Background Image Var into the TI-83 Premium CE
emulator view in TI-SmartView™ CE software.

On the TI-83 Premium CE, a Background Image Var displays as the background in the
graph area only. A background image will display scaled for the MODE screen settings
of Full, Horizontal, and Graph-Table. This preserves any mathematical modeling done
on a background. You cannot edit a background image while working on the TI-83
Premium CE. Background images run from and are stored in Archive memory.

16 Using the Calculator Explorer Workspace



Send a Background Image for use in the CE Graph Area

You can send a background image and display it in the graph area of the color
calculator.

NORMAL FLOAT AUTO REAL RADIAN MP n

O N O v Pk wnNPRE

9.

Open the Tl Connect™ CE software.

Choose the Calculator Explorer workspace.

Connect the Tl color calculator to the computer using the cable.

Turn on the Tl color calculator.

Choose the image you want to convert.

Drag the picture to the Calculator List Panel and hover over the desired calculator.
Release the mouse button when you see ¥ Copy |

Select an Image# name from the drop-down menu (Image0 - Image9). This will be
the name of the image on the Tl color calculator.

Note: The Image# name you choose becomes the image name on your calculator.
Note this Image# name (or make it part of the file name on your computer) for
identification when you want to send or share this file.

WARNING: Pre-loaded images are stored in Imagel - Image5. Use other Image# to
avoid overwriting the pre-loaded images.

Click Send.

Note: Rename the computer file so you can identify your Image Var later (bridge,
fountain, etc.) The Image# internal calculator var name will not be changed.

Note: To save the background image to your computer, drag the Image# from the
Calculator Explorer to your desktop or to the folder where you want to save it.

To display your new background image in the graph area of the Tl color calculator,
press [format] change the Background setting to the Image# you just sent to the
calculator (example: Image5), and press [graphe].

Note: From the graph screen on the calculator, you can also change the Background
using [dessin]; BACKGROUND; 1:BackgroundOn interactive command.

Using the Calculator Explorer Workspace 17



Data Import

The Data Import feature lets you convert/send spreadsheet data saved as csv data files
to the calculator as calculator list(s) or matrice(s) files.

Access the Data Import feature from the Calculator Explorer Workspace.
Highlights:
e (Create (or download) a spreadsheet of data.

e Prior to import, edit data in your spreadsheet software to only allowed calculator
numeric formats (specified below) for the import to a calculator file.

About the spreadsheet

e Only one spreadsheet saved as a CSV (Comma Delimited) (*.csv) file will be
imported via Calculator Explorer workspace at a time.

e Spreadsheet (csv) file can be dragged into the Calculator Explorer or imported via
Actions > Import Data (.csv) to List/Matrx... menu.

e Upto 6 calculator lists or 1 matrix from the spreadsheet data will send to the
connected calculator.

Rules for preparing the spreadsheet for import:

e All cells must contain Real Number data as experienced on the calculator and no
text.

- Complex numbers are not supported for data import.

- If decimal numbers are represented with the use of a comma in the *.csv file,
the file will not convert using the Data Import Wizard. Please check your
computer operating system number formatting and convert the *.csv to use the
decimal point representation. The calculator list and matrix editor use the
number format as, for example, 12.34 and not 12,34.

e Data must start in cell Al

e List(s) Import: If calculator lists are desired:

&2 Importer vos données X

Avant d'importer votre feuille de calcul enregistrée au format csv,
assurez-vous que vos données commencent dans I3 cellule

A1, contiennent uniquement des valeurs numériques réelles et
ne contiennent pas de texte

Sélectionnez le type de fichier e calculatrice pour la conversion :

NOM DE FICHIER : temp_data.csv

COLONNES :
{7} Listes v 1 v

ANNULER CONTINUER

- Only six spreadsheet columns A-F will be imported

18 Using the Calculator Explorer Workspace



- Columns can be of length up to 999 cells.

- The first empty cell in a column will be interpreted as the end of the data for
that list import

e Matrix Import: if calculator matrix is desired:

2 Importer vos données X

Avant d'importer votre feuille de calcul enregistrée au format csv.
assurez-vous que vos données commencent dans la cellule

A1, contiennent uniguement des valeurs numériques réelles et
ne contiennent pas de texte.

Sélectionnez le type de fichier de calculatrice pour la conversion :

NOM DE FICHIER : temp_data.csv

LGNE:  COL: CELLULES :

L] Matrice v 2 x|2 4

ANNULER CONTINUER

- Only one matrix can be imported from a spreadsheet file.

- Up to 400 cells can be imported. (Example: row x col: 10 x 5 = 50 cells from
row range 1-10, columns A-E.)

- Dimension of matrix of the form (row x column) will be requested during the
import experience in Calculator Explorer.

- Any empty cell within the specified matrix dimension will be interpreted as 0.

¢ Do not have data in the spreadsheet outside of the allowed sizes for list(s) or
matrix as described above. Otherwise, the file will be invalid when a data import
to Calculator Explorer is attempted.

To save calculator list(s) or matrix files

e To save calculator files created to the computer, after import/send to calculator,
drag the list(s) or matrix file from Calculator Explorer to the desired computer
location.

Deleting Calculator Files
You can delete data, files, and programs from your calculator.

To delete files from the calculator

1. Click on the file in the Content Panel you want to delete.

2. Press .
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Quit Exam Mode Setting on Connected Color Calculators

Quit the exam mode setting on your Tl color calculator by connecting Tl color calculator
(s) to the computer and selecting

e Actions > Calculatrices Couleur : quitter le Mode Examen in Tl Connect™ CE.

Reminder: Use the latest CE Bundle at education.ti.com/83ceupdate to ensure your CE
has the latest and appropriate calculator files for your TI-83 Premium CE Edition Python
or TI-83 Premium CE.

20 Using the Calculator Explorer Workspace
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Converting and Sending Python Programs
Convert a Python Program to use with the Python App

A Python program (*.py) from your computer will convert to the calculator Python
AppVar when you send the file to your CE Python enabled calculator using TI Connect™
CE. Then, using the appropriate Python App for your calculator, you will be able to edit
and run your Python program. Download the appropriate version of the Python App for
your TI-83 Premium CE model and latest OS version at education.ti.com/83ceupdate. It
is best to update your calculator using the latest CE Bundle (OS and Apps) using Tl
Connect™ CE to ensure you have all updated calculator files.

Note: The TI-82 Advanced Edition Python runs the Python82 App. The Python programs
are PY AppVars. As always, run a Python program on your calculator to see if the
Python modules are supported.

Reminder: For any computer/TI-Python experience: After creating a Python program in
a Python development environment on the computer, please validate your program
runs on the calculator/emulator in the TI-Python experience. Modify the program as
needed.

See Python App eGuide for details on TI-Python.
See Python82 App eGuide for details on TI-82 Advanced Edition Python

When you send your *.py program file(s) using Send to Calculators, the action is similar
to sending any other file to the calculator.

2 envoyer aux calculatrices X | @ Nomsurla calaulatrice x

NOM DE FICHIER : NOM SUR LA CALCULATRICE EMPLACEMENT : _
Les noms personnalisés AppVar Python peuvent

Python01.py PYTHONO1 v Mémoire RAM Vv contenir jusqu'a 8 caractéres,

Le premier caractére peut étre une lettre de A3 Z. Les
CALCULATRICES DE DESTINATION:  Personnalisé caractéres restants peuvent étre une lettre de A3 Z, _ou

® Toutes les calculatrices connectées D) sélectionnez des calculatrices Un chifire de 0 & 9

V] Remplacer le contenu existant portant le méme nom sur les calculatrices de destination

ANNULER ENVOYER m

FILE NAME: Displays the computer file name of your *.py file(s).

Note: This may differ from the NAME ON CALCULATOR depending on what you
named the Python program on your computer.

NAME ON CALCULATOR:

¢ If the computer file name follows the Python AppVar naming rules, then the Python
AppVar calculator name populates with the computer file name. Naming rules are
shown on the screen above.

- Lower case will automatically change to upper case letters.
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e If the computer file name does not follow the Python AppVar naming rules, then
the NAME ON CALCULATOR populates with PYTHONO1, PYTHONO?2, etc.

e Change the NAME ON CALCULATOR using the Custom naming option in the pull
down. You must follow the naming rules for the Python AppVar.

LOCATION:

e Choose to send the Python AppVar to the calculator’s RAM or Archive memory.
- The default is RAM.
- The Python App will only edit and run Python AppVars in RAM.
e Store Python AppVars in Archive memory on the calculator when you
- do not have enough memory in the Python App experience as stated in the App.

- do not wish to see the Python AppVars load into the Python experience until a
later time when you move them from Archive to RAM on the calculator.

Note: To move a Python AppVar between RAM and Archive memory on your CE
Press [mém] 2:Gest. Mémoire/Suppr.... > B:Var App...
Press on each AppVar to toggle from RAM to Archive (denoted by *).
DESTINATION CALCULATORS:

» Select whether you want to send the program to all connected calculators, or just
selected calculators (from a check list).

Which AppVar is a Python AppVar?
You will be able to identify your Python AppVars as follows.

In TI Connect CE Calculator Explorer, the Python AppVar will display as “AppVar
Python.” Here, SCRIPT1 and VABSOLUE are Python AppVars.

o SCRIPT1 AppVar Python
@ VABSOLUE AppVar Python
[ cownicsp Appvar
[ currcaz AppVar

Note: The Python AppVar will send to other 8x family calculators but will not be
accessible on those calculators.

Press [mém] 2:Gest. Mémoire/Suppr.... > B:Var App... will display PY at the right of
the screen.

[HORMAL FLOTT AUTO REEL RAD MP

MEM RAM LIB 158917
MEM ARCH LIB 1591K

» AIRECARR 430 PY
*AIRETRI 390 PY
CRBRI 130
*CNVKLM 269 PY
CNVTEMP 238 PY
*CONICSD 109
CurrCal3 140
FACTRIEL 493 PY
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Send or Convert a Python AppVar to the Computer (*.py or *.8xv)

You can send a Python program from your calculator to your computer as a Python
program (*.py) or a Python AppVar (*.8xv).

e Option 1: Drag and Drop

- Drag and drop a Python Program (PY AppVar) from a connected CE calculator to
the computer. Program will save with the *.py extension and will be available
to edit in a text file. As previouly mentioned, sending a *.py file to a CE Python
enabled calculator or emulator will convert to the correct PY AppVar file for use
in the Python App.

e Option 2: Actions > Send to Computer
- Send to computer with option to send as a Python program (*.py or *.8xv):
- Select a Python AppVar in Calculator Explorer.
- Select Actions>Send to Computer.

- By default, the file will save as *.py. If needed, select the *.8xv extension in
the pull down to save the PY AppVar to your computer. Note that the PY
AppVar cannot be edited as a text file on your computer. Recommend to
save as *.py for flexible use of your CE Python program on your computer.
Again, *.py programs convert to the correct CE file format when sending to
a connected calculator or to a TI-SmartView Python enabled emulator.

Note:

- After converting a Python AppVar back to a *.py computer file, please check
the syntax, spacing, line breaks, and Python specific items in your computer
Python software. Make necessary modifications specific to the version of
Python you are using on the computer. Python versions vary.

- When saving the conversion to *.py back to your computer, it is best to save
the program to a new *.py name on your computer to avoid overwriting
your original *.py program.

Convert an image for use in the Python App with the ti_image Add-On module
The ti_image Add-On module is available in the latest CE Bundle update.

e education.ti.com/83ceupdate

e education.ti.com/fr
For more information on using ti_image and the Python App, please see

e Python App eGuide for details on TI-Python.
e Python82 App eGuide for details on TI-82 Advanced Edition Python

The ti_image Add-On module offers a method “load_image(“name”). The argument
“name” is the calculator name of an image you will convert to a specific AppVar for
use in the Python App.
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Note: The image conversion for the CE Python experience is different from the CE OS
Background Image conversion used in the OS graph area . While the steps are similar
in the Explorer Workspace, please read the prompts for the best outcome.

1. Drag your image (*.png) to the connected [
calculator in the Explorer Workspace.

asen

2. For a Python image format, please pull down e
NAME ON CALCULATOR and select Python e T
Image... .

Notes: ——
e Image0 —Image9 are reserved for the OS
Background Image Vars.
e You will create a unique name for your Python
image AppVar. -

e If you are changing a Python image name, you
will see the previous name in the pull down.
Select Python Image... to change the current
name as well.

3. Enter a CALCULATOR FILE NAME following the IR
naming rules provided. Remember the @
calculator name of your image for use in the
Python App ti_image Add-On module method
load_image(“name”). s

4. IMAGE SIZE IN PIXELS: Enter the WIDTH and

HEIGHT for the converted image.

a) The original image size in pixels is
provided. Note the pixel ranges for Row
width and Column height provided to avoid
sizing errors.

b) Check the box to maintain the aspect ratio
of your original image.

c) Select CONTINUE. The image will convert
to the AppVar format.
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d) The Send to Calculator dialog will display.
SEND to a CE Python enabled calculator.
See the Python e-Guide for more details on
ti_image Add-On module.

Reminder: For any computer/TI-Python experience: After creating a Python program in
a Python development environment on the computer, please validate your program
runs on the calculator/emulator in the TI-Python experience. Modify the program as
needed.

See Python App eGuide for details on TI-Python.
See Python82 App eGuide for details on TI-82 Advanced Edition Python
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Using the TI-Basic Program Editor Workspace

The TI-Basic Program Editor Workspace allows you to work with Tl Basic programs.

Nouveau programme

_I_

Ouvrir le programme

-

26 Using the TI-Basic Program Editor Workspace



Parts of the TI-Basic Program Editor Workspace
_iolxl

Fichier

Modifier  Afficher  Actions

=
-

(3]

Nouveau programme

_I_

Ouvrir le programme

-

Menu Bar - Use these menus to manage files and programs, and to get help.

Fichier Modifier Afficher Actions Ressources Aide

Note: In the Program Editor Workspace, you can only drag and drop
programs to the Content Panel.

Toolbar - Click these icons to Create new program, Open program, Save
program to computer, Send program to connected calculator(s), Undo, or Redo
and Font Size Slider.

+ @8 # S ¢ @ A
06 o0 5] 6

Create new program.

Open program.

Save program to computer.

[~ ol

Send program to connected calculator(s).
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® Undo or Redo.

® Font Size Slider to increase or decrease the size of text in:
e (Catalog Panel
e Program Editor

@ Content Panel - Use this panel to create, view, and edit programs.

Nouveau programme

_|_

Quvrir le programme

-

Catalog Panel - Use this panel to select your calculator type and then choose
from the catalog tree list (by category) to create programs.

» Angle

» Catalogue

» Car

» Distribution

» Dessin

» Fonctions financiéres
* Format

» Liste

* Maths

» Matrice

» Mémoire

* Mode

» Programme

» Statistiques

» Représentations Stat
* Config Table

» Test

» Variables

» Zoom

Syntax Reference Panel - Use this panel to view the proper syntax of each
command along with required and optional arguments.
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AsmComp (prgmASHM1, prgmASH2)

Creating a New Program

When no programs are open, the Content Panel displays only the New Program and
Open Program icons.

To create a new program Nouwezl programme
> Click the New Program icon. _I_
To open an existing program Cnntiepragarie
1. Click the Open Program icon. ._1
2. Navigate to the appropriate folder. -
3. Click Open.

Editing a Var Name

New program names are PROG##. The numbers run in sequence, ex: PROGO1,
PROGO2.

To change the program name

» Click inside the Var Name box and type in a new name up to 8 letters or numbers
(first cannot be a number.)

VAR NAME:  PROGO1

Protecting Your Program

Tl Connect™ CE software allows you to protect your program from being edited after
the program is sent to a connected calculator.

To protect your program

» Click the check box next to the lock icon. H
Saving a Program to Your Computer

The asterisk at the beginning of a program name indicates that the program is not
saved.

To save a program

1. Click .
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2. Navigate to the appropriate folder.
3. Click Save.

Closing a Program
To close a program

» Click the x by the program name.
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Using the Catalog Panel

The Catalog Panel contains a list of calculator commands, functions, variables, and
symbols you can use to create programs.

Note: Select your calculator from the pull down. For TI-82 Advanced Edition Python, we
suggest to use the TI-83 Premium CE family catalog.

Please select only the TI-82 Advanced Edition Python commands and functions as
described in the Reference Guide. Running unsupported commands and functions will
result in an Invalid error on the TI-82 Advanced Edition Python.

To expand or collapse a Catalog level

» Click the triangle beside each Catalog entry.

TI-83 Premium CE v *Sans titre3.8xp x
» Clavier
NOMVAR: PROGO4
* Angle
» Catalogue
< 1]
» Car

» Distribution
» Dessin
» Fonctions financiéres
»* Format
» Liste
¥ Maths
* Maths
* Numérique
» Complexe

* Probabilités

Fraction

/

»F4»D
»nid<orUn/d
» Matrice

Référence pour |a syntaxe

Aucune sponible
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To place a Catalog entry in the Content Panel

» Drag and drop the Catalog entry into the Content Panel. This places the cursor in
the program editor command line after the item is dropped.

-OR-

» Double-click the Catalog entry. This pastes the item to the program editor and the
focus remains in the Catalog Panel to select another item. Click back at the end of
the command line to continue typing in the editor.

To avoid Syntax errors

Use the catalog of commands and symbols to paste to the editor to avoid syntax errors
due to the incorrect use of upper and lower case in commands.

Example:
Did you type Eval( or eval(?

Did you type sin( or Sin(?

The catalog
tree list pastes | Ti-84 Plus CE ~ *Untitled1.8xp X
the correct
case and DispGraph

space DispTable VAR NAME:  PROGO1
formatting. »DMS
Dot-Thick
Dot-Thin
DrawF

l @21 eval(

Drawlnv
DS<(

e

e

E

PEFF(
Elss
End

Eng
EqurString(
ExecLib
expr(
ExpReg
ExprOff
Expron
Fodf (

Syntax Reference
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Extra Space Syntax Errors

Running a Program on a Calculator

Extra spaces can cause a Syntax error when a program is runs on the calculator.

Where are the extra spaces?

You can see extra spaces in your
program using Tl Connect™ CE Program
Editor by selecting the entire program.
Extra spaces at the end of command
lines should be deleted prior to sending
the program to the calculator.

When the program runs in the calculator, if there are extra spaces, selecting Goto from

VARNAME: SNAKE

the syntax error screen will place the cursor on the program line where the error
occurred. Check the line for correct syntax and extra spaces at the end of the command

line.

URMAL FLOAT AUTN REAL RADIAN MP
([PROGRAM LINE 11

ERROR: SYNTAX

tQuit
PHGoto

tX>dim(L1)
:X+dim(Lz)
tFill{(B,L1)
Fill(A.Lz2)

iRereat KE45 —

VARNAME:  SNAKE

ClrHome
1344
548

344D
Xadin (L1)
Xadin (Lz)

Fill(A,L2)
Rspeat K,48

LaP)at t)
Output(EA 7
B+L1 (P)

Cursor lands on error./

e Move cursor to the end of that command line.

AsLz(P)
P+1-X(P=X)+P

getKeysK

If max(K={24,25,26,34})
KO

A+ (D=28) - (D=24)»A
B+(D=34)- (C=25)+8

A+26( )- (A=27) ) +A
B+18( (B=0) - (B=11) )+B
End
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e Carefully delete extra spaces.

Note: There is no undo on the calculator.

HORFAL FLOAT AUTO REHL EADIAM HF n HORRHL FLOAT AUTO KEAL RABIAN mF n

PROGRAM: SNAKE PROGRAM : SNAKE
:ClrHome tClrHome
:13+A +134A
:5+B 1548
:1@9X 109X
14p 14p Spaces
134D 134D
) |:Xedim(Lal r¥edimila) B
1Xddimilz) s ¥Aadim(lzd
:F1il1(B.L1} :F1il11(B.L1)

When Do Commands Become Calculator Commands (Tokens)?

The commands do not become calculator commands (tokens) until the program is sent
to the calculator.

If there is an error when your program sends to the calculator or runs on the calculator,
check to see if every command in the calculator program edit mode is actually a
command token.

How Do You Know?

When a command is a token on the calculator, the cursor will be on the first character
and then jump over the command as a token. If the cursor moves letter-by-letter
through a command, that command did not get converted. Delete and paste the
command from the calculator.

PROGRAM: B PROGRAM: B
— iEnvBinom( iinvBinom(l E,:HZ;EOC:E’:L;LESZ?OT;_C”UFSDr
It only understands the
characters as a function or
command name.

Reminder: When entering a program directly on the calculator, the command or
function pastes completely as a token.

Warning: Some calculator commands such as LEFT, CENTER, RIGHT, FRAC, are words
you might use in a string. If a word you use in a string is the same as a calculator
command, your word will become a calculator token and may give errors in your
program. Avoid using words or parts of words that are the same as a Tl-Basic
command to avoid unintentional tokenization to a command.

Warning: The language setting of TI Connect™ CE determines how the text is
interpreted as a command token for the calculator. Opening programs and sending
back to the calculator with Tl Connect™ CE in different languages may result in:

e undesired command tokens and/or

* syntax errors
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Using the Syntax Reference Panel

The Syntax Reference Panel displays the syntax of each Catalog entry, including
required and optional arguments.

Réfé e pour |a syntaxe

Pt-Changer(x,y[,n®couleur])
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HUB menu for TI-Innovator™ and TI-Innovator™ Rover

Program Editor supports the TI-Innovator™ HUB menu for TI-Innovator™ and TI-
Innovator™ Rover commands. The HUB menu is located in the Program menu in the
catalog tree. This HUB menu addition to the Tl Connect™ CE Program Editor is the
same HUB menu experience as when the Hub App is loaded on the CE calculator.
Please always use the latest versions of the CE OS and CE Hub App.

Note: If the Tl Connect™ CE Program Editor HUB menu does not contain some of the
latest HUB commands, please type in the commands in the Program Editor as needed.

Note: The TI-82 Advanced Edition Python does not support connectivity with TI-
Innovator™ and TI-Innovator™ Rover. There is no HUB menu available for programming
on the calculator. Programs using HUB commands will error.

Always update with the latest CE Bundle.

For the 83CE Bundle go to education.ti.com/83ceupdate
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See Also:

Using the Catalog Panel

Sending a Program to a
Calculator

TI-83 Premium CE v

¥ Programme

» Contréle

» Input/Qutput

» Couleur
T

» Send("SET
* Send("READ

Settings
Wait
Get (
eval (
Rover (RV)...
Send ("CONNECT-Output
Send ("CONNECT-Input
* Ports
Send ("RANGE
Send ( "AVERAGE
Send ("DISCONNECT-OQutput
Send ("DISCONNECT-Input
* Manage

v

L4

L4

v

v

v

v

v
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Sending a TI-Basic Program to a Calculator

You can send a program to a connected calculator.

To send a program to a connected calculator

1.

If you have not already done so, save the program.

h|
CIick.

FILE NAME: This may differ from the NAME ON CALCULATOR depending on what
you named the program on your computer.

NAME ON CALCULATOR: select the program name (it should be the default, but you
may change the program name by clicking Custom).

2 envoyer aux calaulatrices x  Nom sura calelatrice x

NOM DE FICHIER NOM SUR LA CALCULATRICE EMPLACEMENT Les noms personnalisés Programme peuvent conten
- 8 jusqua 8 caracteres.
LINESXD LINE v Mémoire RAM v/

_ Le premier caractére peut étre une lettre de A& Z ou le
caractére . Les caractéres restants peuvent étre une
CALCULATRICES DE DESTINATION:  Personnalisé lettre de A4 Z, 6 ou un chiffre de 09

® Toutes les calculatrices connectées O Sélectionnez des calculatrices

(] Remplacer le contenu existant portant le méme nom sur les calculatrices de destination

LOCATION: Choose whether you save the program in the calculator's RAM or
Archive.

DESTINATION CALCULATORS: Select whether you want to send the program to all
connected calculators, or just selected calculators (from a check list).

To send programs to multiple calculators

1.
2.
3.

Select the Select Calculators button on the dialog box.
Check the boxes to next to the calculators you want to select.
Click Send.
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Language Settings

If you wish to develop a TI-Basic program in a language different than your computer
0OS language setting, you can re-launch Tl Connect™ CE in another language.

1. Select File > Change Language.

2. Select the language change after restart of the application.

#2 sélectionner une langue X

Redémarrez I'application pour que le changement de langue soit pris en
compte.

Frangais v

m QUITTER PLUS TARD QUITTER MAINTENANT

e QUIT LATER - Retains the language selected and Tl Connect™ CE will launch in this
selected language the next time Tl Connect™ CE is launched.

e QUIT NOW - Closes the software app. Tl Connect™ CE will launch in this selected
language the next time Tl Connect™ CE is launched.

e CANCEL - No language change. Computer OS language will be the default.
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Maintaining Your Calculator
Updating Your Calculator

Tl CE Bundle file — use one computer file to update your CE calculator!

Update your connected CE calculator(s) in one step using Tl Connect(TM) CE and the TI
CE Bundle.

Update with the latest CE Bundle at:

e education.ti.com/83ceupdate

Connect your CE calculator(s) to TI Connect™ CE. Drag the appropriate Tl CE Bundle to
Calculator Explorer.

Tl Connect™ CE will update your CE OS, any CE Apps that need to be updated or are
missing from your calculator(s) and also load the 5 pre-loaded Image Vars to Imagel —
Image5. The process cannot be stopped so make sure to save off (drag off) any of your
favorite calculator files using Tl Connect™ CE Calculator Explorer. You can drag your
favorite calculator files back to your calculator after the new TI CE Bundle process
completes.

Drag the CE Bundle to Calculator Explorer. Please wait until the complete process
finishes. Do not pull the cable during any file transfer. Expect the CE calculator to
reboot prior to the Image Var and Apps transfer. Expect the CE calculator to
defragment (rearrange memory) at some time during the process. Messages display
when transfers take place on the Tl Connect™ CE window.

Note: The Tl CE Bundle contains all the latest files you need to update or restore your
CE calculator(s) as though you just bought your calculator and provides a fast way to
update your class set

CE calculator(s).

Important: If the CE calculator screen says "Waiting..." the calculator has lost the OS.
This can happen if a cable is pulled from the calculator or computer during a file
transfer. If connected, disconnect and reconnect the CE to the computer. Drag the CE
Bundle to Calculator Explorer.

Reminder: Wait until the complete process finishes. Do not pull the cable during any
file transfer. Expect the CE calculator to reboot prior to the Image Var and Apps
transfer. Expect the CE calculator to defragment (rearrange memory) at some time
during the process. Messages display when transfers take place on the Tl Connect™ CE
window.

You may repeat this process and the CE Bundle will transfer the files again. Do not pull
the cable during any file transfer.

See Also:

Sending Files Between Connected Calculators
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Update TI-8x Plus Calculators or TI-82 Advanced Edition Python
Tl Connect™ CE software lets you download operating systems for graphing calculators.
Download the latest operating system for your calculator at education.ti.com/fr

Before you begin
e Backup your calculator files.
e Make sure your calculator is turned on and securely connected to the computer.

¢ If you have multiple calculators connected with USB computer cables, OS transfers
can occur to specific calculators.

This can be done by selecting the specific calculators in the Send dialog.

Warning: Do not disconnect the cable during a transfer.

To update graphing calculator operating systems
1. Click Actions > Send OS.

2. Navigate to the correct OS file for your model of calculator stored on your
computer.

3. Click Open..

The Send OS dialog box opens.

#2 Envoyer [0S X

Fichier d'0s:

TI82 Advance

ATTENTION : L'envoi de I'OS efface le contenu de la mémoire des calculatrices de
destination. En revanche, les éléments archivés (applications, images
d'arriére-plan, etc.) ne seront pas supprimés. Voulez.vous envoyer I'OS

maintenant ?

CALCULATRICES DE DESTINATION :

») Toutes les calculatrices connectées ®) Sélectionnez des calculatrices

V| TI-82 Advanced-AD6E

__| Remplacer le contenu existant portant le méme nom sur les calculatrices de destination
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4. Select from Destination Calculators:

CALCULATRICES DE DESTINATION :

_) Toutes les calculatrices connectées ®) Sélectionnez des calculatrices

V] TI-82 Advanced-AD6E

5. Press Send e
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Getting Calculator Information

Tl Connect™ CE software allows you to get information about your calculator's type,
product ID, OS Version, RAM, Archive, Language, ROM Version, and Hardware Version.

* Note: Calculator Information is available only from the Calculator Explorer
Workspace.

¢ Note: Always down load the latest TI CE Bundle at education.ti.com/83ceupdate or
education.ti.com/fr for your specific Tl calculator.

To view calculator information
» Click View > Calculator Information.

Note: The TI-83 Premium CE Edition Python and TI-83 Premium CE will both display
the appropriate product names.

= . .
=2 Informations sur la calculatrice *

Calculatrice : TI- ‘emium ( dition Python
ID Produit :
) Version de I'0S :
i MEMOIRE RAM :
- — - Archive :
' - : Langue :
Version de la ROM :

Version Matérielle :

Compatibility with Graphing Calculators

Please refer to the TI-83 Premium CE Getting Started Guide for compatibility with
graphing calculators.

Apps, Operating Systems and some data files with unsupported numeric types do not
share between models.

TI-Basic programs may need to be modified to correctly display on the higher
resolution color screen models.
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General Information
Online Help

education.ti.com/eguide

Select your country for more product information.

Contact Tl Support

education.ti.com/ti-cares

Select your country for technical and other support resources.
Service and Warranty Information

education.ti.com/warranty

Select your country for information about the length and terms of the warranty or
about product service.

Limited Warranty. This warranty does not affect your statutory rights.
Updates

education.ti.com/83ceupdate

education.ti.com/fr
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